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KeePass Password Manager Tutorial

Instructor: Mr. Alwin Tareen

Task Overview

o Setting up the KeePass password manager for Windows and Mac OS. Linux users should meet
with me for assistance with this setup.

Setting up the KeePass Password Manager

e A major component of this course is submitting programming assigments to Web-CAT, an
external website for autograding. However, this website requires each student to be assigned
username and password credentials.

o In past versions of this course, large numbers of students had inexplicably lost, misplaced or
forgotten their login credentials. This meant that I had to query the database directly to retrieve
their information, which was a time-consuming process.

o In order to alleviate this situation, I am requiring each student to use the KeePass Password
Manager to access the Web-CAT grading website.



Installing the KeePass Password Manager: Windows Operating Systems

e Go to the KeePass website at: http://keepass.info|and click on the Downloads link. I have
indicated it below with my cursor.
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o Click on the big green button corresponding to Professional Edition KeePass 2.36
Installer. I have indicated it below with my cursor.
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e You will be directed to the SourceForge website, where you will be prompted to select a location
to save the executable file. I have chosen to save it in my Downloads directory.
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e Double-click on the KeePass-2.36-Setup.exe file to begin the installation process. I will be
using a Windows 10 operating system to demonstrate this.

o The first window that appears is the Select Setup Language window. Confirm that the
English option is selected, then click on the OK button.

Select Setup Language X
Select the language to use during the
installation:

English e

oK Cancel

e The next window that appears is the Licence Agreement. Select the radio button
corresponding to I accept the agreement and click on the Next button.

ﬁ'_:j-! Setup - KeePass Password Safe -

License Agreement

Flease read the following important information before continuing.

Flease read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation.

KeePass: Copyright (C) 2003-2017 Dominik Reichl <dominik.reichl@t- A
online.dex.

The software is distributed under the terms of the GNU General Public License
version 2 or later.

For acknowledgements and licenses of components/resources/etc., see the file
'KeePass.chm'.

GMU GEMERAL PUBLIC LICENSE
Version 2, June 1991 hd

@I accept the agreement
()1 do not accept the agreement

MNext = Cancel




e The following window is the Select Destination Location, which specifies where the
KeePass program should be stored. The default location is fine. Click on the Next button.

ﬁ'ﬁ’ Setup - KeePass Password Safe - X

Select Destination Location
Where should KeePass Password Safe be installed?

Setup will install KeePass Password Safe into the following folder.

To continue, click Next. If you would like to select a different folder, click Browse.

C:\Program Files (%86 2 Browse...

At least 4.7 MB of free disk space is required.

o The next one is the Select Components window, which gives users a choice as to the specific
components to be installed. The default options are fine. Click on the Next button.

ﬁ'ﬁ! Setup - KeePass Password Safe - >
-]

Select Components
Which components should be installed?

Select the components you want to install; clear the components you do not want to
install. Click Mext when you are ready to continue.

Full installation w

Core KeePass Application Files 3.6 MB
Help Manual 0.7 MB
Mative Support Library (KeePass 1.x) 1.3 MB
¥5L Stylesheets for KDBX XML Files 0.1 MB
Optimize KeePass Performance 1.0 MB
Optimize KeePass On-Demand Start-Up Performance 0.1 MB

Current selection requires at least 7.7 MB of disk space.

< Back Cancel




o After that, comes the Select Additional Tasks window. I have clicked on the option
corresponding to Create a desktop shortcut. Click on the Next button.

ﬁ'ﬁ’ Setup - KeePass Password Safe - X

Select Additional Tasks
Which additional tasks should be performed?

Select the additional tasks you would like Setup to perform while installing KeePass
Password Safe, then click Next.

Associate KeePass with the .kdbx file extension
Additional shortcuts:
Create a desktop shortcut

|:| Create a Quick Launch shortcut

e Then, we have the Ready to Install window. At this point, everything should be configured
properly. Click on the Install button.

ﬁ'ﬁ! Setup - KeePass Password Safe - >

Ready to Install

Setup is now ready to begin installing KeePass Password Safe on your
computer.

Click Install to continue with the installation, or click Back if you want to review or
change any settings.

Destination location: ~
C:\Program Files (x86)\KeePass Password Safe 2

Setup type:
Full installation

Selected components:
Core KeePass Application Files
Help Manual
Mative Support Library (KeePass 1.x)
5L Stylesheets for KDBX XML Files
Optimize KeePass Performance
Optimize KeePass On-Demand Start-Up Performance b

< Back Install Cancel




o [f everything has proceeded correctly, you should see the following completion window. Click on
the Finish button.

ﬁ! Setup - KeePass Password Safe -

Completing the KeePass
Password Safe Setup Wizard

Setup has finished installing KeePass Password Safe on your
computer. The application may be launched by selecting the
installed shortcuts.

Click Finish to exit Setup.

Launch KeePass

Finish




Installing the KeePassX Password Manager: Mac Operating Systems

e For Mac users, there is a variant called KeePassX which has virtually all the same functionality
as KeePass.

e Go to the KeePassX website at: https://www.keepassx.org|and click on the Downloads
link. I have indicated it below with my cursor.
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e Then, under the Mac OS X heading, click on the link Binary bundle v2.0.3. This will allow
you to download the installation file. Unfortunately, I cannot give any more detail about the
installation process, because I don’t have an Apple computer.
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Configuring KeePass to Work with the Web-CAT Autograding Website

e Double-click on your desktop icon, or select the KeePass application from your Start menu to
launch the program. You should see the following window appear.

@ KeePass - O X
File Edit View Tools Help
[ & < [ -
Title User Name Password URL Notes
0 of 0 selected Ready.

o The first step is to create a password database file. It is encrypted with one of the most secure
algorithms currently known. Even if an adversary were somehow able to obtain a copy of your
password database file, they would be unable to discover its contents.

e Click on the File menu, then select New. . .

@ KeePass - O X
File Edit View Tools Help
[ New. Ctrl+N B -
Open D User Name Password URL Notes
Open Recent »
Close Ctrl+W
Save Ctrl+S
Save As

Database Settings...

Change Master Key...
Print... Ctrl+P
Import...

Export...

Synchronize

Lock Workspace  Ctrl+L

Exit Ctrl+Q

®© [

0 of 0 selected Ready.




e The Create New Password Database window appears. I have chosen to save my password
database file in a directory named vault, which is a sub-directory of Documents. Generally, I
keep all of my credential files in this vault folder, so I don’t lose track of them. I have decided
to name my file alwinTareenCredentials18Aug2017, and you are free to choose a similar
naming scheme. Once you have finished, click on the Save button.

@ Create New Password Database x
“— v P <« Documents > vault v | Search vault R
Organize ~ New folder = e
A ifi VT
& OneDrive Name Date modified Type
W This PC MNo items match your search.
m Desktop
4 Documents
3 Downloads
D Music
= Pictures
B Videos
% Local Disk (C)
¥ MNehanrk v £ >
I, El =alla lwinTareenCredentials18Aug201 v
Save as type: | KeePass KDBX Files (*.kdbx) ~
A Hide Folders Cancel




e Then, the Create Composite Master Key window appears. Here, you are expected to create
a Master password that unlocks this database file.

e Take care to select a password which is strong, and spend some time memorizing it. Do not lose
this password! If you are afraid you might forget it, then write it down somewhere safe, or take
a photo of the password with your phone. If you lose this password, then there’s no corrective
action I can take, you simply won’t be able to open your database file.

e Type your password into the Master password text box, then type it in again into the Repeat
password text box. Leave the Key file/provider and Windows user account options
unchecked. Then, click on the OK button.

@ Create Composite Master Key >

CUsers\Muzaffar Tareen\Documents'vault\alwinTareenCredentials 18Aug2017 kdbx

Q‘( Create Composite Master Key

Specify the composite master key, which will be used to encrypt the database.

A composite master key consists of one or more of the following key sources. All sources you specify will be
required to open the database. Ifyou lose one source, youwill not be able to open the database.

Master password: [ | I_l.“

Repeat password: | |

Estimated quality: 0 bits Och.

[ ] Key file / provider: (Mone)

[« Create e Browse
Create a new key file or browse your disks for an existing one. f you have installed a key provider plugin, it
is also listed in this combo box.
[ ]| Windows user account

This source uses data ofthe current Windows user. This data does not change when the Windows account
password changes.

i [fthe Windows accountis lost, itwill not be enough to create a new accountwith the same user name
and password. A complete backup ofthe user account is required. Creating and restoring such a
backup is not a simple task. If you don't know how to do this, don't enable this option.




e Then, the Database Settings window appears. This is where you can customize some of the
various settings. The default settings are fine. However, I have typed in a name for my database,
as well as a description. Once you have finished, click on the OK button.

@ Create New Password Database - Step 2 X

‘— Database Settings

._ Here you can configure various database settings.

General Security Compression Recycle Bin Advanced

Database name: |Al's Security Credentials

Database description:

This gives me a safe place to putmy Web-CAT credentials, so | don'tlose them|

Default user name for new entries

] Custom database color

e Now, your password database file should be set up similar to the following window.

@ alwinTareenCredentials18Aug2017 kdbx - KeePass - O x
File Edit View Tools Help

(d |8 - o - W D a{iﬁ'vSearch... -

e alwinTareenCredentials18/| | Title User Name Password URL Notes
wl General ~Sample Entry User Name i http://keepass... Notes
_ﬂ.ﬁ__: Windows g i R R .
= /2 Sample Entr.. Michael321 http://keepass...

) Network
## Internet
=\ eMail
%

7 Homebanking

0 of 2 selected Ready.




e Next, we need to configure KeePass to activate with a specific keystroke combination. Go to the
Tools menu and select Options. ..

@ alwinTareenCredentials18Aug2017 kdbx - KeePass - a X
File Edit View Tools Help
(d |8 - €. Generate Password.. -
alwinTareenCredentiz % Generate Password List... me Password URL MNotes
;‘;.f General & TAN Wizard... me FrEEEER http://keepass... Notes
j :’lgou\.‘r(s Database Tools » F21 R http://keepass...
/' Networ
&% Internet [E] Triggers..
= eMail @y Plugins..
®% Homebanking . :
(o) Options..
L4 >

0 of 2 selected Ready.




e You should see the Options window appear. Most of these options can be ignored. However,
there is a particular set of options that we need to focus on. Click on the Integration tab.

@ Options X

Options

b Here you can configure the global KeePass program options.

(& Security Policy [ Interface B Integration [ Advanced

[] Lock workspace after KeePass inactivity (seconds): 300 =
] Lock workspace after global user inactivity (seconds): 240 =
Clipboard auto-clear time (seconds): 12 =
[] By default, new entries expire in the following number of days: 0 =
Options &

[] Lock workspace when minimizing main window to taskbar

[] Lock workspace when minimizing main window to tray

[] Lock workspace when locking the computer or switching the user
[] Lock workspace when the computer is about to be suspended

[] Lock workspace when the remote control mode changes

[] Exitinstead of locking the workspace after the specified ime

[] Always exit instead of locking the workspace

Clear clipboard when closing KeePass

[] Use 'Clipboard Viewer Ignore' clipboard format {not recommended)

A b Bl e fe b Lo 3 3

e Now, we are in the Integration tab. Our task is to indicate a specific keystroke combination
that will automatically fill in the login and password fields for a website.

@ Options X

Options

b Here you can configure the global KeePass program options.

(i Security Policy [ Interface B Integration % Advanced

System-wide hotkeys

Global auto-type: |CtrI.AIt+A | Auto-type selected entry: |None

Show KeePass window: |CtrI.AIt+K |

KDBX file association

KDEX files can be associated with KeePass. When you double-click a KDBX file in Windows Explorer, they will
automatically be opened by KeePass.

GCreate Association GRemove Association

D Run KeePass atWindows startup (current user)

URL Overrides...




e There is a text box labelled Global auto-type, and we need to indicate a keystroke
combination that will perform this action. Place your cursor inside this text box, and perform the
keystroke combination Ctrl + S. You should see this keystroke combination appear in the text
box. Then, click on the OK button.

@ Options X

Options

b Here you can configure the global KeePass program options.

{ Security Policy [ Interface B Integraion (¥ Advanced

System-wide hotkeys

Global auto-type: |Ctr| +g | Auto-type selected entry: |None

Show KeePass window: |CtrI.AIt+K |

KDBX file association

KDBX files can be associated with KeePass. When you double-click a KDBX file in Windows Explorer, they will
automatically be opened by KeePass.

GCreate Association GRemove Association

[] Run KeePass atWindows startup (current user)

URL Overrides...

e Now, we need to place our username and password credentials inside KeePass. Notice that there
are several sub-folders in the left hand panel that help you to organize your credentials. Click on
the folder marked Internet.

@ alwinTareenCredentials18Aug2017 kdbx - KeePass - O X

File Edit View Tools Help
[dad |8 - @ -0 Q & (@) search.. -

'« alwinTareenCredenti| | Title User Name Password URL Motes
ad General
‘_’3 Windows
7 Network
@ Internet
=\ eMail
©% Homebanking

0 of 0 selected Ready.




e Then, click on the Edit menu and select Add Entry...

@ alwinTareenCredentials18Aug2017.kdbx - KeePass - O X
File = Edit View Tools Help
[4 e g Add Group.. - Search... -
b alw ¥ Edit Group.. User Name Password URL Notes
ot &Y Delete Group Del
i
F <% Add Entry.. Ctrl+
6 ¢ Edit/View Entry.. Return
- Duplicate Entry Ctrl+K
% Delete Entry Del
Select All Ctrl+A
Show Entries »
Show Entries by Tag 3
2, Find.. Ctrl+F
< >
0 of 0 selected | Ready.

e You should see the Add Entry window appear. In the Title text box, type the word Web-CAT.
Then, you must enter your username and password credentials. These have been sent to you
through the EngradePro messaging system, and you must copy them into these text boxes. The
credentials I have placed in there are just for demonstration, they are not my actual ones.

Q< Add Entry

Create a new entry.

Entry  Advanced Properties Auto-Type History

Title: [Web-cAT | lcon: | 6®

User name: |alwin| |
Password: |t:&5#m | o0
Repeat in

Quality: (R 36bits 6ch

URL: | |
Notes:

[ Expires: | 8/20/2017 12:00:00 AM 5] [©

&5 Tools Cancel




e Next, click on the Auto-Type tab. This is where we will link your username and password
credentials to the specific website where they are supposed to be entered.

Create a new entry.

Q( Add Entry

Entry Advanced Properties Auto-Type History
Enable auto-type for this entry

(@) Inherit default auto-type sequence from group
() Override default sequence:
{USERNAME}TABHPASSWORDHENTER} Edit

Use custom sequences for specific windows:

Target Window Sequence Add
Edit
Remove
A
R4
[] Two-channel auto-type obfuscation Whatis this?

é\‘; Tools Cancel

e Open up a web browser, and go to the course website, located at the following URL:
https://altareen.github.io/aslevelcompsci|Then, click on the Web-CAT link located
under the Problem Sets heading.

Mivez=AfEr - ] X
[} Problem Sets | apcomps: X
< C' O | & Secure | https://altareen.github.io/apcompsci/ | O
2% Apps Y Bookmarks Bookmarks 2017 ™M Gmail @ Google Hangouts »

| Add Entry
K%
View on GitHub @

Create a new entry.

Entry Advanced Properies Auto-Type History

Enable auto-type for this entry

]
a pcom pscl (@ Inherit default auto-type sequence from group
(O Override default sequence:
Course website for AP Computer Science A | Beijing [USERNAME}{TAB}{PASSWORDHENTER} Edit
Natlonal Dav SChOO| Use custom sequences for specific windows:
TargetWindow Sequence Add
Edit
Remove
A
Problem Sets -

D Two-channel auto-type obfuscation Whatis this?

Web-CAT: The official link for problem set submissions

Due Date Description File File Name | L Toots Cancel



https://altareen.github.io/aslevelcompsci

e Now, I am at my Web-CAT website. Go back to the Add Entry... window, and click on the

Add button.
[Mitizatiag - O X
[) Login x
€ C OO Notseaure  ecr54-6520732aportheas.. @ % O
% Apps Y Bookmarks Bookmarks 2017 ™M Gmail @ Google Hangouts i Add Entry
Create a new entry.
Web-CAT Automatic Grading Using Student-written Tests

| Entry Advanced Properties Auto-Type History

Enable auto-type for this entry

(@ Inherit default auto-type sequence from group
(O Override default sequence
{USERNAME}TABHPASSWORDHENTER} Edit

Use custom sequences for specific windows:

Target Window Sequence Add
Edit
Remove
A
v
[] Two-channel auto-type obfuscation Whatis this?
[ srean %] com

o The Edit Auto-Type Item window appears. There is a drop-down list corresponding to
Target window. Click on this drop-down list, and select the option Login - Google Chrome.
Note: If you are using another browser, it might show up as Login - Internet Explorer or
Login - Safari. Then, click on the OK button.

@ Edit Auto-Type Item bt

“? Configure Auto-Type Item

Associate a window title with a keystroke sequence.

Target window:

P Login - Google Chrome
) Skype
Saved Pictures

©{¢ Snipping Tool
@ Use defaultke Program Manager

O Use custom keysiroke sequence:

I{USE‘.RNAME} {TAB} { PASSWORD} {ENTER}

Insert placeholder:

Standard Fields:
{Title} {UserMame} {Password} {URL} {Notes}

Key Modifiers:
Shift + Cirl: *, Alt: %

Special Keys:
{TAB} {ENTER} {UP} {DOWN} {L EFT} {RIGHT} {HOME} {END} {PGUP} {PGDN} {INSERT}
{DELETE} {SPACE}

o] e




e The Add Entry window should look like the following screenshot. Essentially, we have
connected your username and password credentials with the title of the Web-CAT webpage. This
is how KeePass knows to place the correct credentials into Web-CAT. Click on the OK button.

@ Add Entry X

Q( Add Entry

Create a new entry.

Entry Advanced Properties Auto-Type History
Enable auto-type for this entry

(@) Inherit default auto-type sequence from group
() Override default sequence:

{USERNAME}TAB}HPASSWORDHENTER} Edit
Use custom sequences for specific windows:
Target Window Sequence Add
[EZ] Login - Google Chrome (Default) -
Edit
Remove
A
N 4
I:‘ Two-channel auto-type obfuscation What is this?
#5 Tools OK Cancel

e Next, you must save your changes. Go to the File menu and select Save.

@ alwinTareenCredentials18Aug2017 kdbx* - KeePass - O X
File Edit View Tools Help
[ New. Cri+N || Q - Search... -
Open ’ User Name Password URL Notes
Open Recent Y TAT alwin R
@ Close Ctrl+W
[ Save Ctrl+S
Save As »
#, Database Settings..
& Change Master Key...
ety Print.. Ctrl+P
& Import..
& Export..
Synchronize »
Lock Workspace  Ctrl+L
@ Exit Ctrl+Q
< > ||
Group: Internet, Title: Web-CAT, User Name: alwin, Password: *****#** Creation Time: 8/20/2017 2:35:04 PM, Last
Modification Time: 8/20,/2017 3:04:18 PM
1 of 1 selected |Ready‘




o At this point, everything is set up properly, and you should be ready to execute the keystroke
combination. Note that it only works when the KeePass application is open. Go to the Web-CAT
website and place your cursor inside the text box corresponding to User Name. Then, perform
the keystroke combination Ctrl + S.
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o [f you have configured KeePass correctly, then you should see your username and password
being entered automatically, as well as the Enter key being pressed. You should then be inside
your Web-CAT account. If you weren’t able to achieve this, then something must have went
wrong during the setup process, and you should see me for further assistance.



